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  阅前须知  

  1.如果你只是心血来潮，那么不建议你成为一个 modder。目前的氛围是，modder的地位是垫底 的 ，玩
家总是能抓着你地图的问题不放。尽管有些时候是玩家自己脑子不好思路不对或者基本功 不扎 实使导致卡
关，他也会照样骂你地图做得脑瘫。如果你借鉴一些官图中一些比较难的设计， 玩家又 会骂你是在故意为
难人，但是他们不会这么评价官图。如果你的图做简单了，大家会觉得 太简单没 意思；如果你做得难了，
玩家又会觉得你是个变态，他更喜欢休闲图。只有那种一进版 面就自动给 你塞100 个草莓，然后每一个格
子都放上望远镜，每走一步都有存档点的图才不会受 到刁难。虽然 说 modder 的工作就是设计地图，然后
交给玩家体验。但是，现在大多数玩家都是 把自己当成上帝 的，在你面前拥有绝对的话语高地，他们认为
玩你的图是给你面子。所以说，与 其做地图，你还不 如去写 tas。一般的人并不懂tas，不会花时间去看
你 tas 的每一行，也不会对 tasser指手画脚。一个做的其实很糟糕的 tas反而能赢的更多人的追捧。如果
你觉得你可以接受这 些事实，那么欢迎 你成为 modder

 
  

2.你需要能成功地装上 Ahorn或loenn（本教程ahorn与loenn基本通用

   

3.本教程只针对入门级问题

 
  

4.本教程不涉及如何写代码，要学写代码让呆鸡出教程。对于一些实体的细节行为特性（比如
crush

 

block 的迷惑触发判定），你可能想阅读代码（需要一些基础代码能力），这时候你可以 去 下载
Dnspy 然后打开 Celeste.exe

 

 

 

   

mod结构

 
在 Celeste/Mods 文件夹里新建一个文件夹，取名为 Dongline（你可以随意更改这个名字） 作 为

本次教程的示例 mod，或者你也可以随便找一个现有的 mod来自己修改。

 

一个完整的 mod 会包含以下内容：

   

—Audio 文件夹，可选，用来放自定义音乐

   

—Dialog 文件夹，必需，用来放文本内容

   

—Graphics 文件夹，可选，用来放自定义贴图

   

—Maps 文件夹，必需，用来放地图文件

   

—Tutorials 文件夹，可选，用来放自定义残影动画

 
  

—everest.yaml 文件，必需，这是你 mod的身份证
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在 everest.yaml 文件里（推荐使用VSC与 Sublime 等工具打开，不要用 txt 打开），需要写入你的
mod 名 称、版本号、环境依赖等内容，

例如：

 

 
Name 字段写上这个 mod 的名称，Version 写版本号，版本号根据自己的创作进度来决定。

Depenencies 字段写上依赖，即你的 mod 需要什么前置 mod 或者至少什么版本的 Everest 才能 运行。每
次你更新了你的 mod 之后，记得也要更新everest.yaml 里的内容。（0.5版本后的 loenn可以自动填写
前置）

 

 Maps 文件夹的结构如下：Maps/{作者名}/{地图集名字}/{地图}.bin

 

例如这是我做的第七套地图了，所以我就命名为 Maps/Dong/6，而具体的地图文件等之后 Ahorn
教程再添加：  

 

一般而言，新手的第一份地图集可以直接取名叫 0，第二份叫 1，之所以采用这样的命名 方式只

是便 于作者自己记忆防止重名而已，你也可以不用 0123 之类的计数方式来命名地图集。
 

 
其他文件夹的具体内容将在之后进行介绍。  

 

 

  Ahorn使用教程 

 创建地图以及房间  

打开 Ahorn，左上角 File->New，然后输入一个地图名字（这个名字是 Ahorn 内部识别地 图的名
字，而不是地图文件的名字，可以随便起），在这里我起名叫DJNB，然后点击 Create

 

Map 创建地图。
接着 File->Save 保存地图，第一次保存需要为这个地图文件起名并选择保 存位置，我们起名为
DJNB.bin 把它放进Maps/Dong/6 文件夹里。

你也可以复制一张官图的 地图文件到 Maps/Dong/6 文件 夹 里 ， 然 后 File->Open来读取 这张
地图。官图的地图文 件位于Celeste/Content/Maps里。
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首先我们新建一个房间。左上角 Room->Add，然后填写房间属性。下面提到的房间属性 不一
定在你的 Ahorn 里有，这与Ahorn 版本有关系。  

RoomName 是房间的名字，一般以 a_01、b_04 之类的方式命名比较方便，其中 a 代表这 是第一
个存档点，01 代表这是这个存档点的第一个房间。这样命名只是方便作者自身而已 ，你可以随意起
名字。作为示例我取名为 a_01。这里有一点要注意，如果你的房间名字以 ”lvl_”这四个字母开头
，那么游戏会自动忽略掉这个前缀（事实上官图的房间命名风格 就是这样的），也就是说”lvl_a_01
”和”a_01”这两种房间名在游戏内部都会被当成是”a _01”，然后可能引发 bug，所以我的建议
是永远不要用这个前缀来给你的房间命名。

 
Colour 是你房间的颜色。你可以在游戏里进入 3A，然后 debug 模式下打开地图（一般 是 F6

键），你会看到 3A 不同的房间有不同的颜色，这就是 Colour 的作用。这个值你可以 不填，因为它
不会影响游戏体验。

 

X 和 Y 是你房间的坐标。在 Celeste 中，向右为 X 正方向，向下为 Y正方向。两个紧紧 挨着的
房间可以切板穿越。在 Ahorn 中，你可以按 Alt 加方向键来移动房间的位置，所以 初始的 XY 值你
可以不填写。如果你的房间太大导致 Alt 移动房间要移动很久，那么还是建 议你手动算一下 XY 的
值或者安装

 

AhornMoveRoomTool。  

Width 和 Height 分别是房间的长和高。默认值是 40×23，这也正好是游戏屏幕的大小 。 
Camera

 
Offset

 
X和Camera

 
Offset

 
Y将在以后谈到镜头相关的Trigger时介绍。

 

Wind  Pattern 决定了房间是否刮风。  

Underwater 如果勾上，那么整个房间将被水淹没。

 

Space 如果勾上，那么房间将有低重力、上下穿屏效果。参考 8A 最后一面。

 

  

 

Checkpoint 如果勾上，那么这个房间就是一个存档点。具体将在之后介绍。

 

Dark如果 勾上，那么整个房间将一片漆黑。参考 5A 瞎子摸路。

 

Whisper 如果勾上，房间将会有人低语的声音。参考 5A 镜子世界。

 

剩下的四个 music

 

layer 不作过多介绍。1A 的”10z”房间和”10zb”房间之所以音乐 有差
异，就是 music

 

layer 的效果。

 

Ambience

 

Progress 和 Music

 

Progress 不作介绍。第九章“和谐”与“再见”这两个存 档点
用的是同一首音乐，但是音乐听起来不太一样，这就是 Music

 

Progress的效果。

 

Music 字段决定了房间音乐。当玩家进入这个房间的时候音乐会自动切换。如果这个字 段空着
不写，那么玩家进入房间时将沿用原来的音乐。所以一个明智的做法是只给存档点的 第一个房间设

置音乐，这样当你日后想修改音乐时只要改这个房间就可以了，否则你要把每 个房间的音乐全都改

一遍。

 

填完所有内容之后点 Add

 

Room 就能添加房间了。以上所有内容都可以通过Room->
Configure 来修改。

 

 

 

Disable
 
Down

 
Transition

 
如果勾上，玩家向下切板会摔死。参考

 
7A

 
的

 
06

 
旗

 



5 
 

 
Tool 中的前 6 个都是用来画墙壁的，只是画法不太一样。比如 Circles 是画圆， Lines 画线

。我个人喜欢用 Rectangles 来画墙壁。Layer 的 fgTiles 表示这个墙是前景墙， 即玩家可以爬或者
撞到的墙，bgTiles 则是背景墙，纯粹添加美观度的。前景墙和背景墙的 区别在 4A 蓝心的拿法上就
有体现。Material 则是墙的材质，这个你自己去试。如果你想要 删掉一块墙，那么要把 Material
选成 Air 然后画。

 
比如我现在随便画了一些前景墙壁：  

 

Tool 的下一栏 Object

 

Tiles 是用来画破损的墙壁的，一般是为了提示隐藏。比如7A 的 1500
m 的宝石的入口处看起来特别黑，就是 Object

 

Tiles的功劳。Object  Tiles  需要 放在fake
 

wall之
类的实体砖上。

 

下一栏 Placements 是作图最重要的部分。分为四个 layer：

1.entities，即实体，所有玩家可以交互的内容，例如刺、煤球、云、弹簧等。

2.triggers，即触发器，当玩家进入触发器时触发特定的事件。

3.fgDecals，即前景装饰物，它会把玩家挡住。

4.bgDecals，即背景装饰物，玩家可以把它挡住。这些东西的详细作用之后再说。

 

最后一栏是 Selection，用于选中玩家之前放置的东西方便修改。修改的办法是左键 选中
之后右键。

 
随便画好墙之后，下一步是放上重生点。玩家无法进入没有重生点的房间，所以为了 日后的

测试，我们要放的第一个实体就是重生点。Placements->entities 找到 Player( Spawn

 

Point)，然
后放在地图上。如果你开着游戏，那么你每次保存地图与更改mod内容之 后游戏都会立刻重载你的
房间，这对于调试很方便。如果游戏没有自动重载，你可以用

 
F5

 
强制刷新。

现在把目光移到 Ahorn的右侧：
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实体与触发器

 

你可以用各种实体和触发器来丰富你的地图。绝大多数实体和触发器在游戏中你都
很熟悉了，所以请自行结合官图摸索。下面只提一些注意事项。

 

1.Badeline

 

Boost，即共舞的紫球，这个东西有多个结点，你每触摸一个结点之后它都会飞
到下一个节点去。这种有多个结点的东西还有很多，例如第六章的boss等。所有有结点的东西都

可以选中然后按”N”键来添加结点。Badeline

 

Boost 的属性（选中然后右键）里有一项是”
Final

 
CH9

 
Boost”，如果你带着金草莓，同时背景里有一个大黑洞，那么badeline 会把你扔到一

个叫”end-golden”的房间里去。这就是第九章金草莓限定面的实现方式。你可以用这个特性来
实现自己的金限定。

 

2.Badeline

 

Boss，即第六章的boss，它的最后一个结点如果被玩家碰到会导致游戏崩溃
，所以最后一个结点一定要放在玩家碰不到的地方，官图的做法是把最后一个结点放到房间外

。你可以通过选中然后按方向键来移动它到房间外，或者用鼠标直接拖到房间外，或者直接修

改结点的坐标。一旦你把一个实体挪到房间外，想重新选中它就变得有点困难，你需要把鼠标

估摸着放在房间外来尝试选中它，然后用方向键移回到房间内 。

 

3.Crystal

 

Spinner，即水晶刺，有各种颜色。通过按方向键来调整位置总是以一格为单位
移动（8像素），如果按住Ctrl再按方向键就可以逐像素移动。假如你放了一堆蓝色的刺，然后
想全都改成红色，那么你可以通过双击一个刺来选中所有刺然后一起改。假如你放了一堆蓝色刺

和红色刺，然后你想把红色刺改成紫色，这时候双击会把蓝色和红色刺全都选中，而Ctrl加双

击可以只选中所有红色刺，即所选中的同类实体会更加苛刻。上面这些技巧对其他实体也是通用
的。水晶刺还有一个特点，如果房间名字是”boss-19 ”，且你击倒了房间里的Badeline

 

Boss，

那么图上所有水晶刺都会炸裂。

 

 

4.Fake

 

Wall，即假墙，看起来是墙壁实际上可以通过。这类方形的实体都可以通过按“
QEAD”四个键来调整长和宽。如果你先在画墙壁界面的fgTiles 里选好材质，然后再画Fake

 

Wall，那么画出来的假墙也是这个材质。这对所有有材质的实体砖通用。

 

5.Invisible

 

Barrier，即隐形墙。这个实体官图用得非常多，但是你很难注意到。它最主要
的用途是用来阻止玩家往回切板。随便打开第九章和谐部分的一个房间，然后在房间最左侧的地

方（在房间外，选中有点困难）你就能找到隐形墙。此外，Rising

 

Lava 和Sandwich

 

Lava（8A

中上升岩浆和上下移动的岩浆）也是被放在房间外的。

 

6.Kill

 

Box，玩家只能从下往上穿过，如果从上往下碰到它就会表现为摔死。它在 7A 的山
顶部分挺常见。

 

7.Player

 

Playback，这是第九章凌波微步的教程残影。游戏中可以用”capture

 

[文件名
]”的命令把玩家之前200帧的动作录下来，然后用”playback

 

[文件名]”的命令在游戏中编
辑。比如我立刻操作一个ultra

 

dash，然后打开命令行输入”capture

 

ultra”，再输入”
playback

 

ultra”进入编辑页面。编辑页面中按”AD”键调整起始帧的位置，按”←→”键调
整结束帧的位置，调整好之后按”Ctrl+S”保存。保存的残影在Celeste/Content/Tutorials
文件夹 里 ， 把 它 复 制 到 Dongline /Tutorials 文 件夹里，然后在

  

Ahorn

 

的这个实体的

  

Tutorial

 

字段输入”ultra”就能生效了。

 

8.Strawberry，即草莓。Checkpoint

 

Id

 

表示这个草莓在第几个存档点，从

  

0

 

开

 

始计数。
Order

 

表示这是该存档点的第几个草莓，也从

 

0

 

开始计数。这两个值决

 

定了 选关界面中的草莓
位置。使用默认的-1值，游戏将采用eve的自动草莓识别系统。另外草莓也可以按”N”添加结
点，这时候它就变成

 

一个带草 莓籽的草莓。
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然后介绍两个和镜头有关的触发器：

 

1.Camera

 

Offset

 

Trigger，游戏默认把玩家放在镜头中间，如果你想做些偏移就用这个
Trigger。X 偏移 1 代表 6 个格子，Y 偏移 1 代表 4 个格子，支持小数点。例如，如果 Camera

 

Y 填-1.5 意味着镜头将以玩家向上 6 格的位置作为镜头的中央，这对于向上移动的关卡很有
用。这个偏移值也可以在房间属性里修改。

 

2.Camera

 

Target

 

Trigger，这个触发器带了一个结点。如果 LerpStrength 为 0，那么镜
头以玩家为中心，为 1 则以结点为中心。介于 0 和 1 之间的值则按比例以玩家和结点之间的
一个值为镜头中心。

 

其他的触发器，基本上看名字就可以知道是干什么的。我在这里只列举一下触发器可以

实现的功能（不限于一下介绍的）：改变音乐；改变风向；改变光照参数；触发一段剧情；

改变死亡的重生点；触发雪球（请注意，虽然雪球本质上是一个实体，但是它是通过触发器

来生成的）；改变黑洞强度（第九章和谐刚开始的时候画面偏蓝色，到了最后一面的时候画

面偏黄，这就是靠黑洞强度实现的）；决定玩家落地是否可以回复冲刺；改变镜头位置；限

定望远镜的观察范围等。

 

 

  存档点

 

存档点在 Ahorn 中是一个实体，需要在 Room->Configure 中把 Checkpoint 勾上，发现
房间中多了一个存档图标，这就是存档点实体。选中右键，bg 字段是这个存档图标使用的贴图
，可以输入的值为”1,2,3,4,5,5b,6,7,9,10”，其中 5b 是镜子世界的贴图，而”8”之所以不
存在是因为游戏内部的第八章实际上是尾声，而不是核心。如果这个字段空着，那么在游戏里
将看不见存档图标，但是存档点依然起作用。Checkpoint

 

Id 说明这是第几个存档点，从 0 开始
计数。请注意游戏一开始的房间不需要设置存档点，因此如果这个字段填 0，那么实际上在选
关界面看起来它是第二个存档点。Core

 

Mode、Dreaming、Inventory 字段将在以后介绍元数据
时介绍，这几个字段如果设置为Automatic，将会从地图元数据直接继承。最后，当你从选关界
面进入存档点时，游戏将选择离存档点实体最近的那个重生点开始。如果你的房间里有多个重生
点，请拖动存档点实体到你想要开始的重生点边上。

 

 

  元数据

 

metadata，即元数据。Map->Metadata 打开元数据界面，分为三栏 Meta，Mode，Audio，
依次介绍。

Title

 

Banner

 

Icon 是章节的图标，可选值 为”areas /intro ,

 

areas /city ,

 

areas /
oldsite,

 

areas/resort,

 

areas/cliffside,

 

areas/temple,

 

areas/reflection,

 

areas/Summit
,

 

areas/core,

 

areas/farewell”，如果你想自定义图标，参照官图的 Graphics/Atlases/Gui
/areas 文件夹。（你需要在群文件里下载经过反编译的贴图文件即群文件制图工具 辅助 中
的“[图像类] Celeste Graphics Dump v1400”，或者在你的游戏文件夹里 shift+右键然后
选择打开 powershell，输入”./Celeste.exe --dump--all”来手动生成贴图文件）里的文件
自己画图标（比如 我画了 dj.png）以及对应的背面图标（比如 dj_back.png），然后到自己
的 mod 里 把这两个图标放到 Dongline/Graphics/Atlases/Gui/areas/文件夹里，最后在元
数据 界面输入”areas/dj”即可。

     (镜头相关教程推荐阅读冰淇淋的《蔚蓝Celeste Mod 地图镜头优化教程》）

  Meta：
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  Cassette

 

Song 字段是节奏关的音乐，默认使用 1A 的磁带音乐。接下来的三个 Colour 字段
决定了选关界面的颜色，使用 16 进制颜色代码。

  Intro

 

Type 是游戏开始时角色的登场方式，比如 1A 的登场方式是 Madeline 从下面跳上来，
2A 则是 Madeline 睡醒的方式。

  Colour

 

Grade 是滤镜，可以空着。

  Wipe 是死亡重生时屏幕闪过的方式，比如 2A 是一堆气泡，第九章是一堆五角星。

  Darkness

 

Alpha 是光照，决定了游戏有多黑。

  Bloom

 

Base 是基础泛光。这两个值一般直接抄官图。如果你有 DjMapHelper，你可以在游戏
命令行输入 metadata 来查看这两个值。

  CoreMode 是核心效果，即无效果、冰状态、火状态三个选项。一般的地图设置成无效果即可 

  后面的几个字段不作介绍。接着看最下面的三个选项。

  Dreaming 若勾上，背景中会出现星星，参考 2A 梦里和梦醒的背景区别。

  Interlude 若勾上，那么这个地图不会显示死亡数，也不会有 B 面，就像序章一样。最后一
个选项是是否覆盖A 面的元数据。一般而言，B 面 C 面会沿用 A 面的元数据，如果你的 B 面 C
面元数据和 A 面不一样，那么就勾上。  

      Mode：
    Starting

 

Inventory 是玩家的起始状态。具体意义如下：

 

 

冲刺次数

 

是否背包

 

果冻是否启动

 

落地是否恢复冲刺

 

Default

 

1

 

是

 

是

 

是

 

OldSite

 

1

 

是

 

否

 

是

 

Prologue

 

0

 

是

 

/

 

/

 

CH6End

 

2

 

是

 

是

 

是

 

TheSummit

 

2

 

否

 

是

 

是

 

Core

 

2

 

是

 

是

 

否

 

Farewell

 

1

 

否

 

是

 

是

 

Starting

 

Room 表示游戏从哪个房间开始。End

 

Level

 

on

 

Heart 若勾上，那么吃到心就结算
游戏结束。其他选项不作介绍。

 

最后是 Audio 栏，这一栏其实是设置游戏默认音乐的，如果你给你的房间精心设置了音
乐，就不需要管这一栏。
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    CassetteCheckpointIndex是磁带的存档点位置，和草莓一样从 0 开始计数 。
        Mountain 字段是你的章节相对于山的位置，其中 Idle 是选关时的位置。
        Select 是你点了确定并进入 ABC 面选择时的位置。
  

 
      Zoom 是进入游戏时的位置。
      Cursor 是Madeline 的图标所在的位置。   
      这四个值你可以直接抄官图，官图的配置 在Celeste/Content/Overworld/AreaViews.
xml 里。或者你也可以自定义，重启游 戏，在菜单界面按下空格，然后通过”WASDQZ”六个
键移动山的位置，对应的坐 标会显示在左上角。  

State 字段是山的光照，0 代表晚上，1 是黄昏，2 是白天， 3 是月球。ShowCore 字段
决定了是否显示山的核心。

 
接下来是 Modes 字段。现在只需要在地图名后加“-B”与“-C”即可为地图 添加B

面C面，该字段可不填写。只有A面地图需要配套一个.meta.yaml 文件，而B面C面不

 

需 要
。

 

最后是 CompleteScreen ，它是游戏过关时显示的图片。图片的大小必须 是1920×
1080 像素。假如我在Dongline/Graphics/Atlases/EndScreens/Dong/6/ 文件夹下有 CCNB.
png 这么一张图，那么就在对应的 Atlas 字段和 Images 字段 按上图方式填写，其他参数照
抄即可。

 

有一些元数据无法在 Ahorn 里设置，需要我们手动配置文件。

我们现在有DJNB.bin 地图文件，在它边上新建一个 DJNB.meta.yaml 文件，然后配置以下内
容：

以上所有元数据你只需选取自己需要的字段进行填写，不需要的字段直接不写就行。
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     背景

 

背景在游戏中是不可与玩家交互的。请注意将背景和装饰物（即 fgDecals 和bg

 

Decals
）区分开，背景在 Ahorn 中是不可见的，装饰物则是可见的。Map-> Stylegrounds，打
开背景设置，分为两栏，一栏是背景图片，一栏是背景特效。背景 的参数设置比较复杂，所
以我建议你对着官图的背景把参数抄下来就行了。有几个参 数是比较重要的，在这里进行一
下说明：

 

Only 字段和 Exclude 字段决定了这个背景在哪些房间中生效。举个例子，我有 b -1，b
-2，b-3，b-4，c-1 五个房间，我希望这个背景在只在 b-4 不生效，那么我有以 下几种输入
方式：

  ①Only 字段填”b-1,b-2,b-3,c-1”，直接使用”,”隔开。
  ②Only 字段填”b*,c-1”，然后 Exclude 字段填”b-4”，”*”是个通配符， 可 以

匹配任意字符。所以这个背景会对所有房间名包含”b”的房间生效，同时 Exclude 规定了
对 b-4 不生效。如果你希望背景对全图生效，你只需要简单地填写”* ”就可 以匹配所有
房间。Exclude 字段也支持使用”*”通配符。

 

    Flag 和 NotFlag 字段，决定玩家在触发对应flag后是否显示该背景。这俩可以用 于冰
火状态切换，是因为当核心状态为冰状态时，会自动触发名为“cold”的flag。 你想做到
相同效果的话，对着核心的背景设置抄就行。

 

Blend Mode 有两个可选值，addtive 表示直接添加，alphablend 你可以简单理解 成高
透明度模式。

 

FlipX 和 FlipY，表示是否左右翻转或上下翻转。

 

注意一下，第四章吹风时屏幕上飘过的白色絮状物、第九章和谐的大黑洞、第九 章吹
风时的线状特效，这些都是在背景特效里实现的。4D 有些关吹风的时候特效糊了 一脸看不
清路，就是通过叠加了好几层特效实现的。

 

 

     

 

 

 

 

 

 

loop x和loop y，表示背景是否沿x轴平铺或沿y轴平铺。

fade in，决定切换到该背景时该背景是否淡入。

instant in和instant out，令背景切换时更加平滑，防止背景显示又突然消失的 状
况出现。

fade x和fade y，高级背景渐变。格式为 "起始坐标-终止坐标,起始透明度-终止 透明
度"。例如  "n500-500,1-0"。负数用  "n  "表示，而不是用减号。  坐标值以像素为 单位并使
用地图坐标。（游戏内按~可查看当前地图坐标）。可以通过使用":  "作为分 隔符来设置多
个区域。

speed x和speed y，游戏内背景自动沿X轴或y轴移动的速度。该值越高背景远移 动速
度越快。该值为正数时向右（向下）移动，为负数时则相反。该值为0时该背景不 移动。

scroll
 
x和scroll

 
y，玩家移动时背景远离玩家的速度。该值绝对值越 高背景远 离玩

家速度越快。该值为正数时玩家向右背景往左（下），向左背景往右（上）。该 值为负数
时则相反。该值为0时背景跟随玩家镜头，不偏移。
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最 后 讲 讲 存 档 点 的 图 片 ， 它 比 较 麻 烦 。 你 需 要 把 图 片 放 在 文 件 夹
Dongline/Graphics/Atlases/Checkpoints/Dong/6/DJNB/A 里，A 代表 A 面，如果你的
B 面也有存档点那就改成 B。打开游戏，进入选存档界面（建议使用调试档），如下显
示：

 

 

     

自定义贴图
首先建议你仔细查看官图的贴图文件的结构，然后照猫画虎。举个例子，我现在想要

添加一个自己画的装饰物。官图的装饰物在Graphics/Atlases/Gameplay/decals 里，因此
对应地，我只需要在自己的 mod 文件夹里的 Dongline /Graphics /Atlases /Gameplay /
decals/Dong/6 文件夹里放贴图。（在decals文件夹中套文件夹，确保你贴图的路径不会
与其它mod的贴图路径冲突）

填充房间
如果你打开官方地图，会发现有一些小房间是绿色的，而且不可选中。这是被称 为

Filler 的一些房间，作用是防止玩家在切屏的时候导致边缘出现大段空白，尤其是 那种斜
方向的切屏。Ahorn 虽然可以显示官图的 Filler，但是并不能编辑，而且你也不 能创建
Filler。但是我们可以直接创建一些大小合适的空房间，按需要在房间里涂上 墙壁，来充
当 Filler。只要你不在这个空房间里放出生点，玩家就永远无法进入。

  存档点图片

注意看最下面的那个花括号，这就是我们要把文件夹按”Dong/6/DJNB”的方式 来建
立的原因，而最后的”b_01”（这其实是你存档点的房间名字）说明我们需要一 张叫”b
_01.png”的图片（请注意横线）。

自动生成存档点图片：http://postcard.leo60228.space/mask/

start 为名字的，所以你的房间名字最好

不要用 start 来命名。

另外说一句，游戏的第一个存档点总是以

贴图如果命名为aa01，aa02，aa03，那么这个“aa”贴图将会依照“01-03的顺序循
环播放。如果你不想让你的贴图动起来或者没法儿显示，最后别在贴图名字后面加数字。

http://postcard.leo60228.space/mask/
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  自定义音乐

 

首先去 FMOD 的官网下载工具，网址是 www.fmod.com，左键右上角的download ，然后
下载 FMOD  Studio  1.10.*，注意不要下成 2.0 以后的版本。然后你还要下载 Celeste

 

FMOD

 

project ，这也可以在 FMOD 官网找到。然后用 FMOD

 

Studio 打开 Celeste

 

FMOD

 

project，可
以看到左边有 Events、Banks、Assets 三栏。进入 Banks 栏 ，然后 Create->New

 
Bank 新建一

个 bank，我将其命名为 Dongline。之后你为同一个 mod 创作的音乐都可以放在这个 bank 里
。接着切回到 Events栏，Create->New  Event ->New

 
2D

 
Event 创建一首音乐，我将其命名为

NMNB。这时候你会看到界面的中央有一 个 Audio

 

1，把你的音乐拖到这个里面：
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接着右键上面的时间轴和 Audio 1 之间的黑色条，选择 Add Loop Region，为音乐设置一
个循环节。你可以自由拖动循环节的起始与结束位置，让音乐听起来更自然：

点击 Timeline 右边的加号，选择 shared->fade，新建一个 fade 栏。然后在Audio 1 下
面的 Master 那一行，在”0dB”字样处右键，选择 Add Automation，出现一行新的 Volume
栏：

然后拖动红色的虚线，最左边拖到负无穷大，最右边拖到 0，如图：

接下来，Window->Mixer 打开 mixer 窗口，找到你的曲子，然后右键，Reroute into->
music->tunes->mains，然后保存并关掉 mixer 窗口。

回到之前的 Events 栏，右键曲子，Assign to Bank 选择你的 bank，在我的例子里是
Dongline 。接着 File ->Export  GUIDs，生成 guids 文件。最后切换到 Bank 栏，右键
Dongline，选择 Build，完成后在 Celeste FMOD project 的文件夹的 FMOD Studio Celeste 
Project /Build /Desktop 里就可以找到 Dongline .bank，把它复制到你的 mod 文件夹的
Dongline/Audio 文件夹里。然后找到 Studio Celeste Project/Build 里的 GUIDs.txt 文
件，也复制到 Dongline/Audio 文件夹里，并重命名为Dongline.guids.txt。然后打
开这个文件，找到你的曲子所在的行：

http://www.fmod.com/
www.fmod.com


 
 

 

   

 

 

  

 

 

 

 

 

 

  

  

 

 

然后在 Ahorn 的房间属性的音乐一栏输入”event:/NMNB”就可以使用了。

  
自定义对话

分两部分，对话文本和对话动画。

首先谈一谈文本。打开官图的 Celeste/Content/Dialog/English.txt 进行学习。以
”#”开头的是注释。你会发现这个文件中的内容大部分都是”XXX= YYY” 的 格 式，其
中 XXX 就是游戏中的文本代码，比如我们之前在存档点贴图的时候给出一个图片例子，其
中有两个花括号，花括号里的内容就是 XXX，而 YYY 就是你希望游戏里实际显示的内容。
XXX 包括但不限于关卡名字、存档点名字、吃心时显示的文字内容等等，你可以在游戏中
把对应的 XXX 复制过来，然后设置对应的YYY。这部分内容你也可以选几个典型的 Mod 来
学习。要注意”XXX=”之间没有空格，否则游戏会无法识别。

简单翻译一下最开头的注释内容：

1.”#”表示注释
2.”.”会使得文本停顿
3.”{n}”命令会使得文本换行。否则默认的换行是直接另起一页。
4.花括号里的内容是命令，有以下几种命令：
——{~}…..{/~}

 

会使得中间的文字浮动
——{!}….{/!}

 

起强调作用
——{>>

 

x}…{>>}

 

使得中间的文字速度改变
——{#

 

000000}…{#}

 

改变文字颜色，使用 16 进制颜色代码
——{0.5}

 

会制造一个 0.5 秒的停顿
——{big}…{/big}

 

使得文本变大

以上这些命令的用法建议一边阅读 English.txt的剧情文本一边打开游戏观察实际效
果进行学习。

接下来往后看一下对话文本的格式。依然是”XXX= YYY”的格式，XXX是对话的代码
，起识别作用，可以随便自定义，而 YYY 则是具体的文本。每一句对话以以下格式组成：

[角色 左/右 表情]
文本

其中，角色的表情在官图贴图的 Graphics/Atlases/Portraits 文件夹里。官图的对
话文本里还有{trigger……}之类的东西，你不用管，直接跳过这个花括号就行。自己写对
话的时候也不要使用这个命令。不过这样写出来的对话就只是对话，你不能让人物在对话
时移动，也不能让控制镜头缩放。要实现这些高级功能，你必须去写代码。

你需要在 Dongline/Dialog 文件夹里创建一个”English.txt”，并把所有你需要的
”XXX= YYY”写上。你也可以创建”Simplified

 

Chinese.txt”，然后对应的 YYY 就可以
使用中文。但是游戏的中文字库不全，有些字会无法显示，这时候你就需要创建字库 。
但是无论如何，你必须有 English.txt 并写好英文版本的内容。

模仿官图写好了对话之后，我们需要在 Ahorn 里调用它们。默认的，有三种方式创
建 过场剧情：

1.使用minitextboxtrigger，属性里的DialogId就是你的English.txt里的XXX。 5
A 你带着 Theo 吃了个草莓然后 Theo 说你只是在炫耀，这就是这个触发器的效果。这样

触发对话的时候，玩家可以随意移动。

 

2.使用

  

Dialog

 

Cutscene(Everest)这个触发器，只要玩家进入触发器就会触发对

 

话
。

 

3.使用

 

Custom

 

NPC(Everest)这个实体，地图上将出现一个人物，玩家需要按

 

对话
键才能与之对话。但是这个实体用起来比较麻烦。以下先就属性做些说明。

 

Approach

 

Distance

 

表示主角要在多远的位置停下移动然后开始对话。Indicator

 

Offset

 

是对话图
标的偏移位置。Sprite

 

Rate

 

是

 

NPC

 

动画的播放速度。Filp

 

X

 

和

 

Flip

 

Y

 

表示是否在

 

X

 

轴
方向或

 

Y

 

方向翻转

 

NPC。最麻烦的是

 

Sprite

 

属性，这是你要填

 

写的

 

NPC

 

贴图动画 。官
图贴图的

 

Graphics/Atlases/Gameplay/characters

 

文件夹里

 

有所有角色的动作贴 图。
如果你在这个属性字段填写

 

player /idle，那么游戏就会

 

采用

 

Graphics /Atlases /
Gameplay/characters/player/idle00-08

 

的这九章图片来构成

 

动画。但是如果我们想要

 

oshiro

 

的扫地动画，会发现对应的

 

oshiro/sweep

 

图片文

 

件里有把扫把扔地上的贴图，
但是我们不想要这部分贴图，我们只希望

 

oshiro

 

不

 

停地扫地。如果我们在属性里填写

 

oshiro/sweep，会把不想要的贴图也一起弄进

 

来。

 
  

  

——{*}…{/*}

  

使文字抖动
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https://max480-random-stuff.appspot.com/celeste/font-generator
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另外，我在 DJMapHelper 里实现了让 Madeline 分裂出一个 Badeline 然后开始对话的模
板，以及让Madeline接电话然后开始对话的模板。如果你有这个mod，你可以在 Trigger 里
找到这两个模板并使用。

修改于2023/2/3

解决办法是你自己创建一个文件夹然 后把需要的贴图复制过来：创建 Dongline /
Graphics/Atlases/Gameplay/character/ myoshiro 文件夹（以和官图区分）， 把对应的
贴图复制过来，然后在属性里写myoshiro /sweep 就可以了。（如果你不想这么麻烦，可
以试试贴图+隐形的对话npc）
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